
Google Sheets
Handling spreadsheets can be a challenge but with Google Sheets, they will be a walk in
the park. Read on and learn about everything you need to know about Google Sheets!

Google Sheets Definition

Google Sheets is an online program used to add and display information in table form while
allowing multiple users to view it and edit it in real-time.

What Is Google Sheets?

Google Sheets is an online application for creating tables that show data and information in
an organized form. It was developed by the company Google in 2006. It is a part of Google
Doc Editor which helps its users work on various kinds of content. Google Sheets is one of
the best software programs for collaborative projects and works similar to Apple Keynote
and Microsoft Excel.

Main Purpose of Google Sheets



The main purpose of Google Sheets is to provide the tools needed to make a tabulated
representation of data. Whether it be for a budget list, an itinerary, or a checklist, Google
Sheets is your best option to use when making them. It also enables multiple users to work
on the same content in real-time due to its sharing features. This is useful for a lot of
office-related work.

Google Sheets vs Excel

The Pros of Using Google Sheets

● Its User-Friendly
As you will find out in our articles below, using Google Sheets is pretty easy. The
features are all designed for the convenience of users after all.

● Organization
Google Sheets is perfect for someone who likes to be organized. Its features let you
not only organize data but arrange them in any way you like whether it be the usual
table or something visual like a chart. Whether its wrapping text, freezing/unfreezing
cells, making a drop down list, merge/combine, or splitting cells, Google Sheets can
get them done!

● Saved Online
Google sheets are saved online and it does so automatically. This prevents users
from needing to actively save it. Also if the device has gone offline, it prevents users
from having to work all over again since it is all automatically saved online.

● Free
Google Sheets is free for any user. You won’t have to pay at all for using Google
Sheets. All you need to do is have a Google account and you are good to go! In fact,
you may already have one if you have a gmail account. And even if you don’t you
can add this to your device without any hidden charges or payment.

● Multiple User Accessibility
Google Sheet Spreadsheets can be accessed by more than one person in
comparison to its other counterparts. This feature is ideal for those who are working
on the same spreadsheet. You can share it among co-workers, classmates, and
other collaborators.

● It Encourages Collaboration
If multiple people are working on the same spreadsheet, they are able to see the
changes done to the document as soon as possible, making it really convenient. It is
perfect for users who are in a line of work that is inherently collaborative, and even
for those in school.

● Built-in Revision History
Sometimes you need to retrieve the previous version of a Google Sheet spreadsheet
and might have to press the Undo button dozens of times. But you actually do not
have to as Google Sheets has a feature where you can look into the previous
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versions of the spreadsheet’s content, thus saving you the trouble of starting over or
needing an Undo button at all.

The Pros of Using Microsoft Excel

● Unlimited Storage Space
With Microsoft Excel, you can add any amount of data without worrying about
reaching any limit. It doesn’t matter if the file has a hundred or a thousand columns,
the sky’s the limit.

● More Data Visualization Options
You have more options to add visuals to represent your data like bar graphs, pie
charts, and images. So with Microsoft Excel, your data can be displayed almost
anyway you want.

● Advanced Functions
Microsoft Excel has more advanced functions in comparison to Google sheets,
allowing you to organize and process your data more efficiently.

The Cons of Using Google Sheets

● Loading Time
The larger the content of the spreadsheet, the longer it ca take for it to load. This can
be an issue for those who work at a fast pace. However the faster your Internet
connection is, then you won’t spend as much time however.

● Limited Data Visualization
In comparison to its other counterparts, Google Sheets has less options in
visualizing data. This can put a limitation on those who want to get creative in
presenting their content/data on Google Sheets.

● Limited Customization
While you can format cells, change font, size, color, and alignment freely in Google
Sheets, your options of adding images and other visual displays are limited. There is
usually a pre-generated design and you are stuck with that.

● Limited Formulas
In comparison to its other counterparts, Google Sheets don’t have as many formulas.
This can be an issue for those who seek to do a calculation beyond the usual ones.
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The Cons of Using Microsoft Excel

● Collaboration Difficulties
Microsoft Excel files can be only worked on offline. This means, if multiple people
need to work on it, they will need to email the file and keep track of multiple copies.
This can be challenging when it comes to coordination.

● Sole Access
Microsoft Excel files can be only worked on by one person at a time.

● Manual Save
Users have to remember to press the Save button in order to update the changes
made to the Microsoft Excel file.

Similarities

You may have noticed that Google Sheets bear a striking resemblance to Microsoft Excel,
another spreadsheet app that is available to devices with programs provided by Microsoft. It
is not surprising that one gets confused for the other.

Appearance: People often mistake a Google Sheet file for a Microsoft Excel spreadsheet
due to having a similar appearance in their display. From the rows and columns to the
header.

Formulas: Both Google Sheets and Microsoft Excel make use of similar formulas.

Terms: Both terms used in Google Sheets and Microsoft Excel are also the same.

Differences

Language options: Microsoft Excel has around 91 language settings whereas Google
Sheets have 83 options.

Performance: Microsoft Excel works great for a high volume of data. Google Sheets on the
other hand is more ideal for low volumes of data.
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Collaboration: While multiple people can work on spreadsheets from both Microsoft Excel
and Google Sheets, Excel is not very favorable for collaboration when in comparison to
Google Sheets where multiple users can view, work, and edit on it.

Usability Online/Offline: Excel spreadsheets are only in offline mode. It has no online mode.
It is Google Sheets that has an online mode and can be worked on offline as well.
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Google Sheets Templates



If you have a specific table to create, you can save yourself the trouble of starting it from
scratch on Google Sheets. Before you open Google Sheets, you are presented with a lot of
options where you are given a Google Sheet design straight away upon clicking on it. You
can find templates for invoices, budgets, itineraries, business forms, and other similar
content. Here are some examples of templates you can use on Google Sheets.

Invoice

With Google Sheets, you can make an invoice, showcasing the price of the items that were
ordered.

Time sheet

You can keep track of time for either work or personal activities by creating a timesheet in
Google Sheets.

Budget Sheet

If you are a business person or someone who likes to keep track of your personal finance,
you can keep track of all the budget you have for specific projects and activities.

Expense Report

You can use Google Sheets to present an expense tracker you have made whether it is for
a business trip, a party, or for grocery shopping.

Purchase order

You can make a list of items being purchased by customers for your business using Google
Sheets. You can even make columns for the prices and quantities being purchased.

Employee Shift Schedule

You can make a Google Sheet spreadsheet detailing the new schedules of employees in
the workplace. With our feature, you can organize details like the time, names of
employees, and dates, with ease.



Gantt Chart

Keep track of project schedules by making a gantt chart in Google Sheets. You can insert
the bar charts and encode details. You even have the option to do a pie chart or a bar
graph.

Project Timeline

Keep track of your projects and meet the deadlines by making a timeline on Google Sheets.
Its features can help you easily update the progress you have made.

KPI Tracker

You can keep track of the productivity done at work using Google Sheets. Numbering the
data, keeping a note of the progress and history, adding a comment, and coming up with a
score card.

To-do List

Fill up the checkbox as you make a checklist of things you need to do whether it is at work,
at home, or during a trip. You can make one instantly at Google Sheets.

Calendar

You will never miss a date, an appointment, or an event by making a calendar here in
Google Sheets.

Schedule

If you have got a busy day, you can make a schedule form on Google Docs. Details like the
time, location, and people you’ll be seeing can be easily added into the cells.

Planner

You can keep a planner for what is going on in the following days. You can even add
comments to fully describe your plans.



Pros and cons

If you want to make a big decision, consider using Google Sheets to type down the pros
and cons of an idea. Whether you are discussing plans for a party, a trip, a school project,
or a business plan.

Assignment tracker

Helpful when doing a group project for work, school, or other organizational activity. You can
keep track of who is supposed to be doing what.

Google Sheets Free Tutorials

Google Sheets Formulas

Similar to Microsoft Excel, you can make use of formulas to help calculate and process
whatever data you need to do for your content. It involved typing down the Cell coordinates
to specify which information needs to be processed whether it just be two cells, a row, or a
column. The following list includes some formulas that are commonly used and can help
you figure out how to use Google Sheets:

Addition: If you want to add two values, you can add their numbers straight away in one cell,
such as typing in =90+21. You can also be specific and add in the cell they are in, so
suppose 90 and 21 are in cells B3 and B4 respectively, then type in =B3+B4.

Subtract: similar to the addition part above, you can type in =A2-A3 to calculate the values
of the cells. Otherwise, you can also do a quick subtraction by typing =90-21 just like that.

Multiply/Multiple: To multiply something you have two ways of doing that. if you want to
multiply one value that’s in cel D2 by a number, let’s say 2, then type in =D3*2 on the cell
that you want to place your answer. But if you want to multiply two values in two different
cells then simply add their cell designations. For example, you want to multiply D2 and D4,
then type in =D2*D4.

Divide: If you wish to divide a value with a number, you can either type the number itself or
type in the Cell where it is located. For example, if you want to divide 90 which is in cell F4,
with the number 4 you can type either =90/4 or =A3/4.
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Sum: this formula adds the sum of numbers present in the cells. For example, if you want to
add two numbers that are on cells B2 and B3, you can type in =SUM(B2:B3) and that
automatically adds the two values on those cells.

Average: gives the average of a range of cells. For example, you see a range of numbers
from cells C2 to C8, you can type =AVERAGE(C2:C8) and you will get the average of the
values in those cells.

Max: presents the highest value/number among a range of cells. For example, if you want
to find the highest value from cells D4 to D7, you can type =MAX(D4:D7) and you will get
the highest of the values in those cells.

Min: presents the lowest value/number among a range of cells. For example, to find the
lowest number from cells B2 to H2, you can type =MIN(B2:H2) and you will get the average
of the values in those cells.

Median: suppose you want to find the median value within a rage, just type =median from
the beginning of the range till the end. For example, the range starts from A3 to A8, then tye
in =median(A3:A8)

Mode: To find the mode of the value, type =mode long with the range within parenthesis.
Now if for example the range starts from A3 to A8, then type in =mode(A3:A8)

Text: It is a useful formula when you need to convert numbers into currencies. Sometimes it
is easier to type all the numbers down rather than type all the currency symbols and
decimals by hand. With this formula, just type =text and then adding the starting cell number
and ending cell number in a specific range. So let’s say the range is B3 to B19 and you
want to convert them in US dollar currency, then type =text(B3:B19,”$0.00″) onto your
designated cell.

If: This formula lets users check whether certain conditions are either true or false among a
range. The formula is usually shown like this =IF(test then_true, otherwise_false) The test
refers to the value you want to check for. It is quite ideal for data validation.

Count: As its name suggests it is used to count specific values among a range. Say for
example, you want to count how many times a Yes or a No answer was listed from ranges
D4 to D100, then you can type =count(d4:d100) to find out.

These formulas can help you save time from having to calculate and process data, as these
formulas can automatically do the job once you encode a specific formula on the cell. The



best thing as well is that you do not have to type all this down repeatedly if you are
calculating data on a large range. All you need to do is click the cell with the formula and
drag it downwards with your cursor/ This will automatically make the formula apply to the
other ranges as well!

Google Sheets App Download for Free

With these links you can download the Google Sheets application on your mobile devices or
personal computer. They work both offline and online.

● Download Google Sheets for Apple Mac
● Download Google Sheets for Chromebook
● Download Google Sheets for iPhone
● Download Google Sheets for Windows 11
● Download Google Sheets for Windows XP, 8, 8.1, and 10

Google Sheets Guide

Common Terms For Google Sheets

Cell: It is a single point of data within Google Sheets. Usually represented by coordinates
with Numbers at the Row header and Letters at the Column header.

Row: a set of cells at the horizontal position.

Column: a set of cells at the vertical position.

Function: an operation in the spreadsheet app used to calculate, process, and manipulate
data.

Formula: It is a combination of ranges, cells, row, columns, and functions used to get a
certain result.

Spreadsheet: Refers to the whole Google Sheet document that contains your data.
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Worksheet: a set of columns and rows that showcase data and information.

Get Started With Google Sheets

How to Use Google Sheets

1: Log into Your Google Account to Open Google Sheets

2: Create a Google Spreadsheet through Google Drive

3: Create a Google Spreadsheet Directly through Google Sheets

4: Use Functions for Calculations and More in Google Sheets

5: Add Cells, Rows, and Columns to Your Google Sheets

6: Find Options in Google Sheets

How to Organize Google Sheets

1: Organize the Sheet Tabs in Your Google Spreadsheet

2: Create Google Drive Folders to Organize Your Google Sheets

3: Organize Columns in Your Google Spreadsheet

4: Sort & Filter Your Data in Google Sheets

5: Move and Delete Your Spreadsheets in Google Drive

How to Use Google Sheets on Mobile

1: Download the Google Sheets App

2: Log In With Your Google Account Details
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3: Create or Edit Spreadsheets

4: Editing Data In Rows or Columns

5: Formatting Texts

6: Formatting Cells

How to Add/ Manage / Delete Multiple Sheets in Google Sheets

1: How To Add More Sheets To a New or Existing File

2: Renaming Your Sheets

3: Protecting Your Sheets

4: Moving Sheets

5: Duplicating Sheets

6: Hide or Delete Multiple Sheets

How to Insert / Add / Hide Rows or Columns in Google Sheets

1: Click the Insert button

2: Click Rows or Columns

3: Add Rows and Columns by Left Clicking

4: To Hide a Row/Column, left-click the header

5. Click Hide Column/Row

How to Freeze or Unfreeze Rows & Columns in Google Sheets
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1: Highlight Multiple Rows or Columns to Freeze and Unfreeze

2: Open the View Menu and Select Freeze

3: Select the Range of Rows and Columns to Freeze

4: Open the View Menu to Unfreeze Rows and Columns

How to Format Cells, Change Font, Size, Color, Alignment

1: How to Format Cells

2: How to Change Font and Font Size

3: How to Change the Text Color

4: How to Change Alignment

How to Lock or Unlock a Column in Google Sheets

1: Open a New Google Sheet or Reopen a Recent Document.

2: Select the Column to Lock Specific Cells and Right Click to Open Menu.

3: Choose View More Column Actions and Set Permissions.

4: Customize Your Range Editing Permissions.

5: Unlock the Columns on the Protected Sheets & Range Window.

How to Keep a Row Fixed in Google Sheets

1: How to Keep the First Row in Google Sheets

2: How to Keep the Rows in Google Sheets Using the View Menu Options
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3: How to Keep More than Two Rows in the Google Sheets

4: How to Keep Your Desired Rows in the Google Sheets

How to Add & Rotate Text in Google Sheets

1: Add the Text in Google Sheets

2: Format the Added Text in Google Sheets

3: Rotate the Text Vertically in Google Sheets

4: Customize the Degree to Which You Want to Rotate Your Text in Google Sheets

How to Add / Create Drop Down List in Google Sheets

1: Open the Sheets You Want To Edit

2: Choose a cell where you would like to make a drop-down list

3: Select an Option From The Criteria Menu

4: Removing or Hiding the Down Arrows

5: Customize Your Drop Down List

How to Merge / Combine Cells in Google Sheets

1: Merge or Combine Spreadsheet Cells in Google Sheets Using the Format Menu

2: Merge or Combine Your Sheet Cells Using the Merge Cells Shortcut

3: Merge or Combine Multiple Rows in Google Sheets

4: Merge or Combine Multiple Columns In Google Sheets
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5: Merge or Combine Multiple Rows or Columns in Google Sheets

How to Change Cell Size in Google Sheets

1. Select Cell

2. Move Cursor to the Cell’s Axis Headers

3. Hold the Cursor

4. Drag the Borders

5. Move the Borders

How to Move a Row Up and Down in Google Sheets

1: Open Google Sheets

2: Move Cursor to the Row header

3: Click Edit

4: Click Move

5: Choose Where You Want to Move

How to Wrap Text in Google Sheets

1: Select Cell

2: Move Cursor To Menu

3: Click On Format

4: Click on Wrapping
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5: Select Wrap

How to Split Cells Google Sheets

1: Select Text/Column

2: Move Cursor to the Menu

3: Click Data

4: Select Split text to Columns

5: Choose options in the Dropdown

How to View Page Breaks in Google Sheets

1: Select File in the Menu

2: Click Print

3: Click SET CUSTOM PAGE BREAKS

4: Click and Drag Dotted Blue Lines

5: Click CONFIRM BREAKS

How to Make Cell Bigger in Google Sheets

1: Select Cell to Change Size

2: Scroll Up and Highlight

3: Click Hold and Drag

4: Repeat Process on the Side
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5: Repeat Till You Get Ideal Size

How to Password/Lock Protect Google Sheets

1. Install the Feature

2. Click Add Ons

3. Click Activate Password Protection

4. Type in Your new Password

5. Type OK

How to Import a Google Sheets

1. Open Google Sheets

2. Click on a Cell

3. Type =IMPORTRANGE

4. Copy the document’s URL

5. Copy and Paste Cell Range

How to Integrate Forms with Google Sheet

1. Open Your Google Forms

2. Click Responses

3. Press View responses in Sheets

4. Choose Response Destination
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5. Click Create

How to Insert Calendar in Google Sheets

1. Choose a Cell to Start

2. Fill the Cell

3. Select and Drag the Cell until the 7th Cell

4. Type the Date below the Row and Drag

5. Repeat Onto the Next Rows

How to Remove/Hide Gridlines in Google Sheets

1. Open the Spreadsheet

2. Click View

3. Click Show

4. Select Gridline

How to Convert Excel into Google Sheets

1. Open New Google Sheets

2. Click File

3. Select Import

4. Select your Excel file

5. Click Import Data
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How to Turn on Dark Mode in Google Sheets

1. Open Google on your Smartphone

2. Go to the Menu

3. Tap the Settings Icon

4. Click Choose Theme

5. Choose Dark

How to Make Google Sheets Editable by Multiple Users

1. Open the File You Want to Share

2. Click the Share Button

3. Enter the Email Addresses

4. Choose the Type of Access

5. Press the Send Button

How to Highlight Duplicates in Google Sheets

1. Highlight Cells

2. Click on Format

3. Click Conditional Formatting and Add another rule

4. Click on ‘Format cells if’ and ‘Custom formula is’

5. Choose Formatting style options
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How to Insert/Use Pivot Table in Google Sheets

1. Open Google Sheets and Type In Your Data

2. Click Insert

3. Click on Pivot table

4. Click Rows and then Property Type

5. Click Values and then Add

How to Find Percentage in Google Sheets

1. Type in the Numbers

2. Highlight the Numbers

3. Move Cursor to the Menu

4. Click on Percentage Symbol

How to Make a Bar Graph in Google Sheets

1. Select the Data

2. Select Insert

3. Click Chart

4. Select Chart Type

5. Select Bar Section
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